
Oracle Financial Services  
Retail Customer Analytics 

 
Product Installation Manual 

 
Version 6.0.2.0.0 

July 2014 
 



 

Document Control 
Author:  Niraj Ranjan Biswal Group:  OFSAA  

Created on: 04-March-14 Revision No: 1.0  

Updated by: Jyothi Vadde, 

Snigdha Thakuria 

Reviewed by: Usharani Shetty Approved by: Aravind 

Venkatraman 

Updated on: 30th June 2014 Reviewed on: 2
nd

 July 2014 Approved on:  



Installation Manual 

 
 
 

Table of Contents 

About this Manual ........................................................................................................................ 1 

Audience ...................................................................................................................................... 1 

Scope ........................................................................................................................................... 1 

Organization of the Manual ......................................................................................................... 1 

Conventions Used in this Manual ................................................................................................ 1 

Pre-Requisites ............................................................................................................................. 2 

Environment ................................................................................................................................. 2 

Prerequisites ................................................................................................................................ 2 

Front-End Access ........................................................................................................................ 2 

Pre-Installation Activities ............................................................................................................. 4 

OFSRCA v6.0.2.0.0 Product Installation ..................................................................................... 6 

Machine A – Product App Layer .................................................................................................. 7 

Machine B – Product Database Layer ....................................................................................... 20 

Machine C – Product Web Layer ............................................................................................... 27 

Silent Installation........................................................................................................................ 33 

Post Installation Activities .......................................................................................................... 40 

OFSRCA v6.0.2.0.0 Configuration ............................................................................................ 44 

Trouble shooting ........................................................................................................................ 49 

Documentation ........................................................................................................................... 50 

 

  

 



 

1 
 

About this Manual 
The Oracle Financial Services Retail Customer Analytics (OFSRCA) product focalizes on 

Prospect/list scoring leveraging any internal/bureau information, cluster analysis and 

projected NPV, Predictive analysis to determine cross-sell/up-sell scores, product and 

channel propensities leveraging transactional/behavioral data, Customer Segmentation, 

Performance tracking of current campaigns across key measures like Sales, Asset and 

Liability balances, Fee-based product subscriptions and sustained performance over time, 

credit score distribution of new accounts sourced and early alerts on any negative skews, 

Wallet Share (spend diversity, activation, and so on) and Attrition analysis, ROI of campaigns 

over time (transaction performance needs to be measured for at least over 12 months for 

accurate LTV predictions). 

Audience 

This Manual is meant for use by the Oracle Financial Services Analytical Applications 

Infrastructure (OFSAAI) System Administrator. It provides step-by-step instructions necessary 

for installing the OFSRCA v6.0.2.0.0 Product. 

Scope 

This manual provides a step-wise instruction to install the OFSRCA Product in an existing 

OFSAAI hosted in Oracle 11g R2 (11.2.0.2.0) environment. 

Organization of the Manual 

The Installation Manual is organized into the following chapters. 

o Pre-Requisites section identifies the hardware and base software environment that 

is required for a successful installation and functioning of the OFSAAI Solution. 

o Pre-Installation activities section details the pre-installation activities 

o OFSRCA v6.0.2.0.0 Product Installation section details the step-by-step instruction 

on the various installation options. 

o Post installation Activities section details the steps that are required to be 

performed after a successful installation of the OFSAAI Solution. 

Conventions Used in this Manual 

References to sections or chapters in the manual are displayed in Italics.  

Screen names are displayed in the following manner: 

Introduction screen 

Options and buttons are displayed in Bold. 

Notes are displayed as follows: 

Note: 

o It is important that the password should be 6 characters long. If you do not 

adhere to this pre-requisite, you will see a system message that reads Password 

must be at least 6 characters long. 
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o  

Pre-Requisites 
The installation process requires certain environmental variables to be set prior to starting the 

installation. You must ensure that these requirements are met before starting the installation. 

You are requested to refer to the Release Notes for the latest updates on hardware or 

software requirements and the OFSAAI Installation Manual for the environment variables. 

Environment 

Installation of OFSRCA v6.0.2.0.0 Product requires the Oracle 11g R2 (11.2.0.2.0) version of 

OFSAAI v7.3.3.3, to be installed in either a single-tier or multi-tier environment.  It is implicit 

that all base software versions and patch levels required by OFSAAI 7.3.3.3 is available and 

adhered to. 

Note: 

o If you are doing an up-gradation, make sure that OFSAAI has been upgraded 

from v7.2 (Release no – 7.2.10) to v7.3.3.3.  

o The OFSRCA v6.0.2.0.0 installer download contains only the ERwin XML file that 

is required for uploading the model. This file is sufficient to install the v6.0.2 

product. However, this XML file cannot be opened in the ERwin Data modeler 

tool and hence cannot be used for any data model customization. ERwin file is 

delivered as a patch and needs to be downloaded separately. This ERwin file 

should be used for any customization of the data model. The reference bug/patch 

where ERwin file can be downloaded is Bug 18919977. 

Prerequisites 

The Oracle 11g R2 (11.2.0.2.0) version of OFSAAI v7.3.3.3 and OBIEE 11.1.1.7.1 on any 

supported operating system once installed must be configured. The platform patch 18364603 

has to be applied on top of OFSAAI v7.3.3.3. 

After Installation of OBIEE 11.1.1.7.1, the following 3 patches are highly recommended for all 

the customers who are using Oracle Business Intelligence Enterprise Edition 11.1.1.6.0 which 

can be downloaded from Oracle support site. 

o 13742915 

o 13388423 

o 14003822 

The following One-off patch has to be applied on top of OFSAAI 7.3.3.3.0: 

18912901_GENERIC.zip 

Front-End Access 

o Internet Explorer 8.0/9.0 

o Java Plug-in 1.6.0_21 

o Acrobat Reader 8.0 
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o The screen resolutions supported are 1024*768 and 1280*1024 

 Note: 

o Ensure that Java Plug-in is enabled in the browser settings. 
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Pre-Installation Activities 

The following is the Pre-Installation checklist to ensure the readiness to start installing 

the OFSRCA Product: 

o OFSAAI v7.3.3.3 must be successfully installed on Oracle 11gR2 (RAC) (11.2.0.2.0). 

o If Infrastructure installation is on multitier environment, Execute the following commands 

in the DB Layer terminal  

chmod -R 777 < ftpshare folder >  

o Navigate to ftpshare folder and set the umask shown as below, this will make sure all the 

new files created will have 666 file permission.  

cd < ftpshare folder >  

umask 0000 

o The Config and application schema should be two distinct oracle database users. 

o Execute the following grants in config schema. Replace <ORACLE_USER> with Atomic 

schema user. 

grant select on METADATA_MASTER to <ORACLE_USER> 

grant select on METADATA_ELEMENT_MASTER to <ORACLE_USER> 

grant select on METADATA_LOCALE_MASTER to  <ORACLE_USER> 

grant select on BATCH_MASTER to <ORACLE_USER> 

o Oracle database User for Atomic schema should have the below grants 

grant create session to <ORACLE_USER>; 

grant create ANY INDEX to <ORACLE_USER>;  

grant create PROCEDURE to <ORACLE_USER>;  

grant create SEQUENCE to <ORACLE_USER>;  

grant DEBUG CONNECT SESSION to <ORACLE_USER>;  

grant create TABLE to <ORACLE_USER>;  

grant create VIEW to <ORACLE_USER>;  

grant create trigger to <ORACLE_USER>; 

grant create type to <oracle_user>; 

grant select on sys.v_$parameter TO <oracle_user>: 

GRANT CREATE TYPE TO <_ORACLE_USER>; 

GRANT CREATE MATERIALIZED VIEW to < ORACLE_USER>; 

o The same set of privileges has to be granted for the sandbox atomic schema user. 

o Copy the entire OFSRCA v6.0.2.0.0 installer download directory to the server location 

(Including the DataModel directory). Give read, write and execute permission to all the 

files present in this directory. 

o Specify the log file path and name in the log4j.xml. Update the “value” attribute marked in 

the following picture 
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Figure 1: Log4j.xml file configuration 

 

o Make sure the path given in the log4j.xml file has read/write/execute permission. 

o Execute the “config_table_privileges_for_application_user.sql” script in configuration 

schema for both main atomic schema and sandbox atomic schema. This file will be 

present inside $FIC_HOME directory. 

o Make sure FICServer is up and running before proceeding for installation. 
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OFSRCA v6.0.2.0.0 Product Installation 
The OFSAAI Product comprises of components that are installed in Web, Application, and 

Database layer. Hence, if you have installed OFSAAI 7.3 in a multi-tier architecture, the 

OFSRCA Product installer must be invoked on each of the machines that host the OFSAAI 

tier.   

For a Single-tier installation, the installer is required to be invoked only once on the machine 

that hosts all the OFSAAI tiers.  

This section describes the installation process where the three Product setup components are 

installed on separate machines. Machine A will be used to install Product Application Layer 

components, Machine B will be used to install Product Database Layer components and 

Machine C will be used to install Product Web Layer components.  

Note: 

o This section holds applicable if OFSAAI v7.3.3.3.0 is installed on Oracle 11g on separate 

machines A, B, and C respectively. 

o If a silent installation is required, refer to Silent Installation section. 



 

7 
 

Machine A – Product App Layer 

Step 1 

To begin OFSRCA v6.0.2.0.0 product installation, execute Setup.sh. 

 

Figure 2: Installation Splash Screen 

Step 2 

 

Figure 3: Introduction Screen  

Upon invoking the installer, the Introduction screen will display the pre-requisites for 

installation. Ensure that the pre-requisites are satisfied before you proceed.   

Step 3 

Choose the log mode for this installer.  
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Figure 4: Log Mode Option Screen 

 

Step 4 

Provide the 9 digit Customer Identification number provided during the OFSAAI installation.  

 

Figure 5: Customer ID Input Screen 

 

Click Next to continue.
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Step 5 

The Pre-Setup Information screen requests for setup information.   

Select the appropriate OFSAAI layer that has been installed on the machine.  

Example AppLayer 

 

Figure 6: Pre-Setup Information Screen – Choose Application Layer to Install 

Note: 

o For a single-tier OFSAAI v7.3.3.3.0 installation, select Application Layer, 

Database Layer, and Web Layer. 

o For a multi-tier OFSAAI v7.3.3.3.0 installation, select the corresponding layer 

installed on the machine.   
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Step 6 

This panel seeks infromation on whether a new infodom has to be created or the existing 

infodom to be used for apps installtion. Choose the required option. 

 

Figure 7: Pre-Setup Information Screen – Infodom type 

Click Next to continue. 

Step 7-i 

If the option New Infodom was chosen in the previous panel, then the following panel will be 

displayed which will seek information of the following details to create infodom. 

Specify a DB name for the new Infodom and make a TNS entry with the DB name specified in 

the tnsname.ora file in the oracle server. 

Enter the newly created application schema user name, password, and jdbc url in relevant 

fields. 

Click Next to continue. 

 

Figure 8: Database details for the new Infodom 

 

Step 7-ii 

If the option New Infodom was chosen in the previous panel, then the following panel will be 

displayed following the panel 7-i which will seek further information of the following details to 

create infodom. 
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Specify the name and description for the new infodom to be created.  

Specify a segment name to be created. 

Note : Segment and INFODOM  name should not exceed 10 Characters 

Also specify the Application server and database server log path for infodom maintenance (to 

be created) 

 

Figure 9: Infodom details for creation of new Infodom 

Note: 

o The OFSAAI user must have a role that is able to perform Add/Modify functions 

for OFSRCA metadata.   

Click Next to continue.  

Step 7-iii 

If the option New Infodom was chosen in the previous panel, then the following panel will be 

displayed following the panel 7-ii which will display the pre-infodom creation details. Check 

and verify all the details before proceeding to the next step. 

 

 

Figure 10: Pre-Infodom Creation Summary 

Click Next to continue creation of information domain. A new information domain will be 

created on clicking Next. 
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Step 7-iv 

If the option Existing Infodom was chosen in Step 6, then the following panel will be 

displayed which will prompt to select the infodom from list of infodoms present in the setup. 

Enter the segment code and the application schema’s TNS name. 

Segment code should not exceed 10 characters 

 

 

Figure 11: Installation in Progress 

Step 8 

Sandbox Creation: 

Specify whether you want to setup the Sandbox. This process would require fresh infodom 

creation. Hence an empty schema for the same has to be created. Follow all the pre-

requisites mentioned in the Pre-Installation Activities section for application (Sandbox) 

schema. 

 

 

Figure 12: Pre-Setup Information 

Clicking No implies that sandbox creation is not required and the user is prompted for model 

upload step. 

Clicking Yes implies that the following panel will be displayed which will seek information of 

the following details to create sandbox infodom. 



 

13 
 

Specify a DB name for the new Infodom and make a TNS entry with the DB name specified in 

the tnsname.ora file in the oracle server. 

Enter the newly created application schema user name, password, and jdbc url in relevant 

fields. 

Click Next to continue. 

 

Figure 13: Pre-Setup Information 

Specify the name and description for the new infodom to be created.  

Specify a segment name to be created. 

Note: Segment and Infodom name should not exceed 10 Characters 

Also specify the Application server and database server log path for infodom maintenance (to 

be created). 

 

Figure 14: Pre-Setup Information 

If the option New Infodom was chosen in the previous panel, then the following panel will be 

displayed following the panel 7-ii above which will display the pre-infodom creation details. 

Check and verify all the details before proceeding to the next step. 
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Figure 15: Pre-Infodom Creation Summary 

Click Next to continue creation of information domain. A new information domain will be 

created on clicking Next. 

 

Figure 16: Infodom Creation  

OFSRCA v6.0.2.0.0 data model is packaged as part of OFSRCA v6.0.2.0.0 product installer 

and will be installed as part of the upcoming steps, if required. 

The following screen prompts the user to opt for model upload process through installer. 

Step 9 

 

Figure 17: Pre-Setup Information 
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The following panel prompts the user to choose whether the released version of Datamodel or 

the customized datamodel to be uploaded. 

On selecting Released Data Model option, the installer uploads the OFSRCA v6.0.2.0.0 

data model that is packaged as part of the OFSRCA v6.0.2.0.0 product.  

On selecting Customized Data Model option, the installer allows the user to select the data 

model. Choose the required option. 

Click Next to proceed. 

 

Figure 18: Pre-Setup information 

Step 10 

If the option Customized Data Model was chosen, then the following panel will be displayed 

prompting the user to select the customized data model located in the machine. 

Choose the customised datamodel file from the server. 

Note:  

o The data model xml file should be available in the server. 

o In case the installation is being performed on an existing information domain, the data 

model that is planned to be selected in this panel should be merged with the data model 

that was previously uploaded in the information domain. 

If the installation is being performed on a new information domain, then the data model that is 

either customized or merged with other data models can be selected in this panel. 
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Figure 19: Pre-Setup information 

Step 11 

The following panel displays the pre-model upload details. 

Verify the details before proceeding to the next step. 

Click Next to proceed for model upload. 

 

Figure 20: Pre – Model Upload Summary 

 

Click Next to start the model upload process. This process will take some time depending on 

the size of the data model and the available physical memory in the environment. User will 

not be able to take any further action on the screen, until the model upload process is 

complete. This step cannot be rolled back. 

If the model upload fails, then a pop-up with the relevant error and log file path will be 

displayed. 

Review errors and take relevant action. Continue with this step until the model upload is 

successful and the installer takes the user to next step. 

Note: 

Some of the common errors during model upload are: 

o Insufficient heap memory on the client machine 
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o Possible reason/resolution: The java memory settings in “reveleusstartup.sh” located in 

$FIC_APP_HOME/common/FICServer/bin directory should be increased. 

o Error while getting the Erwin File path  

o Possible reason/resolution: Restart the FICServer. 

o Error in Upload Operation:  

 “FAILED WHILE SUPER CATEGORY - SUB CATEGORY RELATIONS HANDLING 

DELETING” 

o Possible reason/resolution: Incorrect Erwin.xsl file version in 

$FIC_APP_HOME/common/FICServer/conf directory.  

o Incremental/Sliced model upload might give errors in case there are NOT NULL columns 

that are being added to a table that already has rows or if the columns that are being 

dropped have values. Check the data model changes excel file for any such cases. In 

such a case, take a backup of the table and truncate the table. Insert records back into 

the table with a default value for the NOT NULL column. 

Navigate to the previous screen and proceed with the steps mentioned above. 

 

Step 12 

The following panel seeks input from the user on whether to create new ETL 

application/source pair or use an existing one. 

In case of upgrade, if the user selects an existing application/source pair, then the existing 

ETL definitions under the source will be over-written with the packaged definitions. User can 

also choose to create a new application/source pair and then merge the changes between the 

packaged definition and their existing definitions offline. 

Choose the required option. 

Click Next to continue 

 

Figure 21: Pre-Setup Information 

Step 13-i 

If the option New application/source pair was chosen, then the following panel will be 

displayed seeking the application and source name for creation of the same. 

Specify all the details required for application and source creation. 



 

18 
 

Click Next to proceed. 

Click Next to create application and source within OFSAAI. Source model will also be 

generated. This process will take some time depending on the number of entities/attributes in 

the application schema. This step cannot be rolled back. 

 

Figure 22: Pre-Setup Information 

 Note:  

ETL Source will be created pointing to the information domain (application schema) 

that is specified during the installation. 

 

Step 13-ii 

If the option Existing application/source pair was chosen, then the following panel willl be 

displayed prompting the user to select app/source pair from the list of pairs already present. 

Choose the required ETL application/source pair into which ETL definitions will be deployed. 

Click Next to proceed 

 

Figure 23: Pre-Setup Information 

 

Step 14 

Specify the OFSAAI user id and OFSAAI Group Name (Specify in Capital Letters). 
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Figure 24: Pre-Setup Information Screen 

 

Click Next to continue. 

 

Figure 25: Pre-Installation Summary 

 

Step 15 

This panel displays all the pre-installation summary. Verify all the details and proceed. 

Click Install to proceed. 

 

Figure 26: Sandbox Summary Screen 
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Click Next to Proceed. 

 

Step 16 

This panel displays the installation process. Wait until it completes. 

 

Figure 27: Installation is in progress 

 

Step 17 

The following screen displays the completion of installation of the OFSRCA Product Setup. 

Click Done to exit. 

 

Figure 28: Installation Complete 

 

Machine B – Product Database Layer 

Step 1 

To begin OFSRCA v6.0.2.0.0 Product installation, execute Setup.sh. 
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Figure 29: Installation Splash Screen 

Step 2 

 

Figure 30: Introduction Screen  

Upon invoking the installer, the Introduction screen will display the pre-requisites for 

installation. Ensure that the pre-requisites are satisfied before you proceed.   

Step 3 

Choose the log mode for this installer. Click Next to proceed. 

 

Figure 31: Log Mode Option Screen 

 

Step 4 
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Provide the 9 digit Customer Identification number provided during the OFSAAI installation.  

 

Figure 32: Customer ID Input Screen 

 

Click Next to continue. 

Step 5 

The Pre-Setup Information screen requests for setup information.   

Select the appropriate OFSAAI layer that has been installed on the machine.  

Example Database Layer 

 

Figure 33: Pre-Setup Information Screen – Choose Database Layer to Install 

Note: 

o For a single-tier OFSAAI v7.3.3.3.0 installation, select App Layer, DB Layer, and 

Web Layer. 

o For a multi-tier OFSAAI v7.3.3.3.0 installation, select the corresponding layer 

installed on the machine.   

Step 6 
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The following panel will be displayed which will prompt to select the infodom from list of 

infodoms present in the setup. Enter the segment code and the application schema’s TNS 

name. 

Segment code should not exceed 10 characters. 

 

 

Figure 34: Pre-Setup Information Screen 

 

Step 7 

Specify the OFSAAI user id and OFSAAI Group name in upper case. 

 

Figure 35: Pre-Setup Information Screen 

 

Click Next to continue. 

Step 8 

This panel displays all the pre-installation summary. Verify all the details and proceed. 

Click Install to proceed. 
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Figure 36: Pre-Install Summary 

 

Step 9 

This panel displays the installation process. Wait until it completes. 

 

Figure 37: Installation is in progress 

 

Step 10 

Specify whether you want to setup the Sandbox. This process would require fresh infodom 

creation, hence an empty schema for the same. Follow all the pre-requisites mentioned in the 

Pre-Installation Activities section for application schema. 
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Figure 38: Post Install Configuration 

 

Step 11-i 

On selecting the option Yes, the following screen will appear. 

On selecting the option No, the steps from 11-i to 11-iii will be skipped. 

Specify all the details for new infodom creation.  

Click Next to continue. 

 

Figure 39: Post Install Configuration 

Step 11-ii 

Specify all the details required for new infodom creation. 

Click Next to continue. 
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Figure 40: Post Install Configuration 

 

Step 11-iii 

Click Next to continue. 

 

 

Figure 41: Post Install Configuration 

 

 

Step 12 
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The following screen displays the completion of installation of the OFSRCA v6.0.2.0.0 

Product Setup. 

Click Done to exit. 

 

Figure 42: Installation Complete 

Machine C – Product Web Layer 

Step 1 

To begin OFSRCA v6.0.2.0.0 Product installation, execute Setup.sh. 

 

Figure 43: Installation Splash Screen 

Step 2 

 

Figure 44: Introduction Screen 
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Upon invoking the installer, the Introduction screen will display the pre-requisites for 

installation. Ensure that the pre-requisites are satisfied before you proceed.   

Step 3 

Choose the log mode for this installer. Click Next to proceed. 

 

Figure 45: Log Mode Option Screen 

Step 4 

Provide the 9 digit Customer Identification number provided during the OFSAAI installation.  

 

Figure 46: Customer ID Input Screen 

Click Next to continue. 

Step 5 

The Pre-Setup Information screen requests for setup information.   

Select the appropriate OFSAAI layer that has been installed on the machine.  

Example Web Layer 
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Figure 47: Pre-Setup Information Screen – Choose Web Layer to Install 

Note: 

o For a single-tier OFSAAI v7.3.3.3.0 installation, select App Layer, DB Layer and 

Web layer. 

o For a multi-tier OFSAAI v7.3.3.3.0 installation, select the corresponding layer 

installed on the machine. 

. Step 6 

The following panel will be displayed which will prompt to select the infodom from list of 

infodoms present in the setup. Enter the segment code and the application schema’s TNS 

name. 

Segment code should not exceed 10 characters. 
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Figure 48: Pre-Setup Information Screen 

 

Step 7 

Specify the OFSAAI user id and OFSAAI Group name in upper case. 

 

Figure 49: Pre-Setup Information Screen 

 

Click Next to continue. 

Step 8 

This panel displays all the pre-installation summary. Verify all the details and proceed. 

Click Install to proceed. 

 

Figure 50: Pre-Install Summary 

Step 9 

This panel displays the installation process. Wait until it completes. 
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Figure 51: Installation is in progress 

 

Step 10 

Specify whether you want to setup the Sandbox. This process would require fresh infodom 

creation, hence an empty schema for the same. Follow all the pre-requisites mentioned in the 

Pre-Installation Activities section for application schema. 

 

Figure 52: Post Install Configuration 

Step 11-i 

On selecting the option Yes, the following screen will appear. 

On selecting the option No, the steps from 11-i to 11-iii will be skipped. 

Specify all the details for new infodom creation.  

Click Next to continue. 
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Figure 53: Post Install Configuration 

Step 11-ii 

Specify all the details required for new infodom creation. 

Click Next to continue. 

 

Figure 54: Post Install Configuration 

Step 11-iii 

Click Next to continue. 
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Figure 55: Post Install Configuration 

 

 

Step 12 

The following screen displays the completion of installation of the OFSRCA Product Setup. 

Click Done to exit. 

 

Figure 56: Installation Complete 

 

 

Silent Installation  
Silent installation is achieved via a properties file [Silent.props] that must be updated with 

proper values, before attempting to install using the silent mode. 

The following table lists all the properties that need to be specified. 

How to install in Silent Mode 

- The installer folder contains a template file “Silent.template” 

- Create a copy of this file and rename the copy as “Silent.props” 

- Edit the file “Silent.props” and specify the parameters as per the requirements 

- On the UNIX Command prompt, execute the following command 

o “Setup.sh SILENT” 
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Refer to the console log [or the file preinstall.log] for any error messages. 
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Property Name Description of 

Property 

Permissible 

values  

Comments 

LOG_MODE Mode for logging 0 = Debug  

1= General 

Optional; 

Default: 0 

CUSTOMER_ID Customer id 

specified while 

installing OFSAAI 

Not 

Applicable 

MANDATORY 

INSTALL_APP Install 

Application-tier 

components be 

installed 

0 = No 

1 = Yes 

Default: 0 

INSTALL_DB Install database-

tier components 

0 = No 

1 = Yes 

Default: 0 

INSTALL_WEB Install Web-tier 

components be 

installed 

0 = No 

1 = Yes 

Default: 0 

OFSAAI_USER_ID Provide OFSAAI 

User ID 

Not 

Applicable 

MANDATORY 

INFODOM_TYPE New Infodom or 

Existing Infodom 

0 = New 

1 = Existing 

# Specify Infodom Type 

Mandatory if this an App 

Layer Installation and option 

selected for 

INSTALL_APP=1 

INFODOM_NAME Information 

Domain(infodom) 

Not 

Applicable 

MANDATORY 

SEGMENT_CODE Segment Code Not 

Applicable 

MANDATORY 

Segment Code should not 

exceed 10 characters 

APPL_TNS TNS Name of the 

Infodom database 

Not 

Applicable 

MANDATORY 

APPL_USER User-id of the 

Database 

Schema for new 

Infodom 

Not 

Applicable 

# Mandatory if this an App 

Layer Installation and want 

to create a new infodom 

# Option selected for 

INSTALL_APP = 1 and 
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INFODOM_TYPE = 0 

APPL_PWD Password  of the 

Database 

Schema for new 

Infodom 

Not 

Applicable 

# Mandatory if this an App 

Layer Installation and want 

to create a new infodom 

# Option selected for 

INSTALL_APP = 1 and 

INFODOM_TYPE = 0 

APPL_URL JDBC Connection 

String of the the 

Database 

Schema for new 

Infodom 

Not 

Applicable 

# Mandatory if this an App 

Layer Installation and want 

to create a new infodom 

# Option selected for 

INSTALL_APP = 1 and 

INFODOM_TYPE = 0 

INFODOM_DESC Description for 

the Database 

Schema for new 

Infodom 

Not 

Applicable 

# Mandatory if this an App 

Layer Installation and want 

to create a new infodom 

# Option selected for 

INSTALL_APP = 1 and 

INFODOM_TYPE = 0 

APPFTP_LOG_PATH Infodom 

Maintenance log 

path(to be 

created) for the 

new Infodom for 

applayer 

Not 

Applicable 

# Mandatory if this an App 

Layer Installation and want 

to create a new infodom 

# Option selected for 

INSTALL_APP = 1 and 

INFODOM_TYPE = 0 

DBFTP_LOG_PATH Infodom 

Maintenance log 

path(to be 

created) for the 

new Infodom for 

DBLayer 

Not 

Applicable 

# Mandatory if this an App 

Layer Installation and want 

to create a new infodom 

# Option selected for 

INSTALL_APP = 1 and 

INFODOM_TYPE = 0 

UPLOAD_MODEL Whether you want 

to perform Model 

Upload 

0 = No 

1 = yes 

Mandatory if INSTALL_APP 

= 1 

MODEL_TYPE Released 

datamodel or 

Customized 

0 = released 

1 = 

customized 

Mandatory if INSTALL_APP 

= 1 
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datamodel 

DATAMODEL The path  for the 

customized 

datamodel 

Not 

Applicable 

# Mandatory only in the 

case  of uploading the 

customized datamodel 

# Option selected for 

MODEL_TYPE = 1 

DM_DIRECTORY The file name for 

the customized 

datamodel 

Not 

Applicable 

# Mandatory only in the 

case  of uploading the 

customized datamodel 

# Option selected for 

MODEL_TYPE = 1 

ETL_APPSRC_TYPE Create new ETL 

App/Src pair or 

use an existing 

one 

0 = New 

1 = Existing 

# Mandatory if this an App 

Layer installation 

# Option selected for 

INSTALL_APP=1 

# 0 = If you want to create a 

new ETL app/src pair 

# 1 = If you want to use an 

existing pair 

ETL_APP_1_DESC Give description 

for the ETL App 

Not 

Applicable 

# Mandatory if you want to 

create new ETL app/src pair 

# Option selected for 

ETL_APPSRC_TYPE = 0 

ETL_SRC_1_1_DESC Give description 

for the ETL Src 

Not 

Applicable 

# Mandatory if you want to 

create new ETL app/src pair 

# Option selected for 

ETL_APPSRC_TYPE = 0 

ETL_APP_1_NAME The ETL 

application name 

Not 

Applicable 

# Mandatory if this an App 

Layer installation 

# Option selected for 

INSTALL_APP = 1 

ETL_SRC_1_1_NAME The ETL Source 

into which the 

Table-2-Table 

ETL definitions on 

staging tables will 

be deployed. 

Not 

Applicable 

This Source must be 

mapped to the above ETL 

Application 
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CONFIGURE_SANDBOX Would you like to 

Configure the 

Sandbox 

0 = Yes 

1 = No 

# 0 = If you want to 

configure Sandbox 

# 1 = If you don't want to 

configure Sandbox 

CRMRCA_DBNAME TNS Name of the 

sandbox 

database 

Not 

Applicable 

# Mandatory if this an APP 

Layer installation and 

CONFIGURE_SANDBOX = 

0 

CRMRCA_USER User-id of the 

Databse Schema 

for new sandbox 

Not 

Applicable 

# Mandatory if you want to 

create a new sandbox 

# Mandatory if this an APP 

Layer Installation and 

CONFIGURE_SANDBOX = 

0 

CRMRCA_PWD Password of the 

Databse Schema 

for new sandbox 

Not 

Applicable 

# Mandatory if you want to 

create a new sandbox 

# Mandatory if this an APP 

Layer Installation and 

CONFIGURE_SANDBOX = 

0 

CRMRCA_URL JDBC Connection 

String of the the 

Database 

Schema for new 

Infodom 

Not 

Applicable 

# Mandatory if this an App 

Layer Installation and want 

to create a new infodom 

# Option selected for 

INSTALL_APP = 1 and 

INFODOM_TYPE = 0 

CRMRCA_SANDBOX OFSAAI 

Information 

Domain(Sandbox) 

into which you 

wish to install 

Not 

Applicable 

# Mandatory if this an APP 

Layer installation and 

CONFIGURE_SANDBOX=0 

CRMRCA_DESC Description of 

OFSAAI 

Information 

Domain 

(Sandbox) into 

which you wish to 

install 

Not 

Applicable 

# Mandatory if this an APP 

Layer installation and 

CONFIGURE_SANDBOX = 

0 

CRMRCA_SEGMENT Segment for new 

sandbox infodom 

Not 

Applicable 

# Mandatory if this an APP 

Layer installation and 

CONFIGURE_SANDBOX = 
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0 

CRMRCA_APPSERVER_FTP_LOGPATH Infodom 

Maintenance log 

path(to be 

created) for the 

new Infodom for 

applayer 

Not 

Applicable 

# Mandatory if you want to 

create a new sandbox 

CRMRCA_DBSERVER_FTP_LOGPATH Infodom 

Maintenance log 

path(to be 

created) for the 

new Infodom for 

dblayer 

Not 

Applicable 

# Mandatory if this an APP 

Layer Installation and 

CONFIGURE_SANDBOX = 

0 

OFSAAI_USER_ID OFSAAI user id Not 

Applicable 

 

OFSAAI_USER_GROUP OFSAAI group id Not 

Applicable 
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Post Installation Activities 
OSAAAI Server Memory Configuration 

The OFSAAI Server is started using reveleusstartup.sh. This file can be edited for setting 

customized memory settings, garbage collector settings depending on the available hardware 

configuration. 

Raise an SR in support.oracle.com if you have any queries related to EPM applications. 

Once the installation of OFSRCA Product is completed, you must perform the following steps. 

o Check the Log file (The path and file name specified in the log4j.xml). 

o Ignore the following errors in the log file: 

o Error: ORA-02260: table can have only one primary key. 

o Error: ORA-00955: name is already used by an existing object. 

o Error: ORA-00001: unique constraint (<<UNIQUE KEY NAME>>) violated.  

o Error: ORA-02275: such a referential constraint already exists in the table. 

o Error: ORA-01430: column being added already exists in table. 

o Error: ORA-02303: cannot drop or replace a type with type or table dependents. 

Configuration in Websphere Application Server 

o Create JDBC Provider for the configuration of connection pool for the above created 
Infodom (Refer to the chapter: Creating the JDBC Provider of the Oracle Financial 
Services Analytical Applications Infrastructure 7.3 Installation Manual). 

o Create a data source to access the data from the database. (Refer to the chapter: 
Creating the Data Source of the Oracle Financial Services Analytical Applications 
Infrastructure 7.3 Installation Manual). 

o After creating a Data Source, click the newly created Data Source ($DATA_SOURCE$) 
and navigate to the path: 

Data sources>$DATA_SOURCE$>Connection pools 

o Set the values for Connection timeout to 0 seconds, Maximum connections to 100 
connections, and Minimum connections to 10 connections as shown in the below figure. 

 

Figure 57: Data Sources 

http://support.oracle.com/
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o Expand the Server Types under Servers option in the LHS menu. Click the WebSphere 
application servers option. This will display the Application Servers page. 

o Navigate to the Web Container option of the application server. Under Custom 
properties, add a new property com.ibm.ws.webcontainer.invokefilterscompatibility 
and set the value to true. 

o Save the new property. Use the below figure for reference. 

 

Figure 58: Application servers 

Configuration in Tomcat Application Server 

o Copy $ORACLE_HOME/jdbc/lib/ojdbc6.jar to the path: 

$TOMCAT_DIRECTORY/common/lib/ 

o Edit the server.xml present under the path $TOMCAT_DIRECTORY\conf\ with the below 

changes, which is required for connection pooling. 

Note: 

Copy the following information into notepad, and then copy it from notepad into xml 

file. Take extra care to avoid copying formatting characters into the xml file. 

<Context path="/ $CONTEXTNAME$" docBase=" $APP_DEPLOYED_PATH$ "   
debug="0" reloadable="true" crossContext="true"> 

 <Resource auth="Container"  

  name="jdbc/ $INFODOM_NAME$" 

  type="javax.sql.DataSource" 

  driverClassName="oracle.jdbc.driver.OracleDriver" 

  username=" $ATOMICSCHEMA_USERNAME$"  

  password="$ATOMICSCHEMA_PASSWORD$"\ 

  url="$JDBC_CONNECTION_URL" 

  maxActive="100" 

  maxIdle="30" 

  maxWait="10000" 

  removeAbandoned="true" removeAbandonedTimeout="60" 

  logAbandoned="true"/> 

  </Context> 

Note: 

o $TOMCAT_DIRECTORY$ should be replaced by Tomcat application installed 
path. 
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o CONTEXTNAME$ should be replaced by OFSAAI context frame. 

o $APP_DEPLOYED_PATH$ should be replaced by OFSAAI application deployed 
path. 

o $INFODOM_NAME$ should  be replaced by Infodom Name 

o $ATOMICSCHEMA_USERNAME$ should be replaced by Atomic schema 
database user name. 

o $ATOMICSCHEMA_PASSWORD$ should be replaced by Atomic schema 
database password 

o $JDBC_CONNECTION_URL should be replaced by JDBC connection string 

Example: jdbc:Oracle:thin:<IP>:<PORT>:<SID> 

jdbc:oracle:thin 10.80.50.53:1521:soluint 

o Configuration in Weblogic Application Server 

o Create JDBC Provider for the configuration of connection pool and a data 

source to access the data from the database for the above created Infodom 

(Refer to the chapter: Creating data Source – WebLogic of the Oracle Financial 

Services Analytical Applications Infrastructure 7.3 Installation Manual). 

After creating a Data Source, click the newly created Data Source 
($DATA_SOURCE$) and navigate to the path: 

Home >Summary of Services: JDBC >Summary of JDBC Data Sources>JDBC Data 
Source<INFODDOM_NAME> 

o Set the values for Initial Capacity to 10, Maximum capacity to 100 ,Capacity 

Increment by 1, Statement Cache Type to LRU, and Statement Cache size to 

10 as shown in the below figure. 

 

Figure 59: Data Sources 

o All Oracle Financial Services Analytical Applications Infrastructure v7.3 Servers must be 

shut down. 

o Oracle 11g service must be running. 

Deploy the EAR or WAR file  

o If the Web-Server is Tomcat, then recreate and redeploy the WAR file (OFSAAI war file). 

(Refer to: Tomcat WAR Files Creation and Tomcat WAR Files Deployment of the Oracle 

Financial Services Analytical Applications Infrastructure 7.3 Installation Manual). Ensure 

that the previously deployed applications in Tomcat are removed before starting the 

redeployment. Start all the OFSAAI servers. All the services should be directly started in 

the server. 

http://10.184.74.118:7001/console/console.portal?_nfpb=true&_pageLabel=HomePage1
http://10.184.74.118:7001/console/console.portal?_nfpb=true&_pageLabel=ServicesJdbcSummaryPage
http://10.184.74.118:7001/console/console.portal?_nfpb=true&_pageLabel=GlobalJDBCDataSourceTablePage
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o If the Web-Server is Websphere, then recreate and redeploy the WAR file (OFSAAI war 

file). (Refer to: Websphere WAR Files Creation and Websphere WAR Files Deployment 

of the Oracle Financial Services Analytical Applications Infrastructure 7.3 Installation 

Manual). Ensure that the previously deployed applications in Websphere are removed 

before starting the redeployment. Start all the OFSAAI servers. All the services should be 

directly started in the server. 

o Start all the OFSAAI v7.3 Servers. 

Note: 

o If you need assistance in starting the servers, then refer to Starting Oracle 

Reveleus Servers in the Installation Guide of Oracle Financial Services Analytical 

Applications Infrastructure 7.3. Profile should be executed before starting any 

activity from the console. 
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OFSRCA v6.0.2.0.0 Configuration 
  

1. Make sure Oracle Business Intelligence (Version 11.1.1.7.1) installation is completed 
with patches (13742915,13388423,14003822) and available.  

 
2. Set the <Oracle BI Instance Home> directory> => e.g. 

/u01/OBIEE11G/instances/instance1.  
 

3. Start Weblogic AdminServer.   
a. Set the < BI Domain Home> directory> => e.g.  

/u01/OBIEE11G/user_projects/domains/bifoundation_domain.  
b. Navigate to < BI Domain Home >/bin and run ‘nohup ./startWebLogic.sh &’ 
c. Bringing up this service may take a few minutes depending on your 

environment.Check the logs using the command ‘tail –f nohup.out’ 
 

4. Start Node Manager.  
a. Set the < WebLogic Server Home > directory> => e.g.  

/u01/OBIEE11G/wlserver_10.3.  
b. Navigate to <WebLogic Server Home>/server/bin and  

run ‘nohup ./startNodeManager.sh &’. 
 

5. Start Weblogic Managed Server (bi_server1). 
a. Login onto http://localhost:7001/console using your Administrator credentials 

created during platform install (Replace the hostname based on your setup). 
b. Under Environment block (mid of page, towards left side), click on Servers 

link. 

 
c. The bi_server1 line should show as shutdown state at this point.  

 
d.  Click on control page tab.  

 
e. Select the bi_server1 line by clicking on the left tick box,  
f. Click Start at the top of the list and confirm starting this service  
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g. State will update to “RUNNING” mode after a few minutes.  

 
6. Start BIEE services and login  

a. Starting services From EM screen  
i. Login to the EM administration screen using the url 

http://localhost:7001/em (Replace the hostname and port number 
based on your setup). Use the login you created in BIEE installation 
to log in.  

ii. Expand 'Business Intelligence' node on the left and choose 
Coreapplication.  

 
iii. Click the Overview Tab,  
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iv. Click the blue button Restart (or green button ‘Start’ ) under the 

Manage System category, middle of screen,  
v. Click Yes on dialog box to confirm the move. Wait for message that 

confirms successful restart.  
 

b. If starting using EM is not successful and complaining about OPMNCTL not 
up, please follow starting process with OPMNCTL. 

i. Open a command prompt, navigate to <Oracle BI Instance 
Home>/bin.  

ii. run “./opmnctl status, this will show you status of all the OBIEE core 
services  

iii. run “./opmnctl startall” or “./opmnctl stopall” depending on your need.  
 
 

7. Deploy RPD and webcat file(s). 
a. Navigate to folder $FIC_HOME/CRMRCA/OBIEE11G/ which contains both 

CRMRCA.rpd and archived CRMRCA. Copy both the files to a local folder. 
b. Login to  

I. OBIEE – Enterprise Manager URL (http://<ip address>:<port>/em). 
II. Click the coreapplication hyperlink from Business Intelligence tab on 

the left. 
III. Under coreapplication, select the tab Deployment and click Lock and 

Edit Configuration button located below title coreapplication. Following 
screen will show up. 

 
IV. RPD Deployment: 

1. Select Browse button available under Upload BI Server 
Repository section and select CRMRCA.rpd file from the local 
folder. Enter the Repository password as “Admin123”. 

V. Web catalog Deployment: 
1. Set the Catalog Location available under ‘BI Presentation 

Catalog’ like: 
“$ORACLE_INSTANCE/bifoundation/OracleBIPresentationServic
esComponent/$COMPONENT_NAME/catalog/CRMRCA” 

2. Now click Apply and then click Activate changes. A pop up will 
be shown after successful activation. 

 
 

3. Click Close and switch to Capacity management tab. 
4. Restart the presentation services. Under the “System 

Components Availability”, select ”Presentation Services” and 
click the Restart Selected option. 
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VI. Once the Presentation Service is restarted, it will give the pop-up for 
successful restart. Click Close. 

VII. Verify that new folder structure is created in the system. It can be found 
under path : 
 <Oracle BI Instance Home> 
\bifoundation\OracleBIPresentationServicesComponent\coreapplication_
obips1\catalog\CRMRCA 

VIII. This ‘CRMRCA’ folder will be having a root folder which in turn contains 
three folders named ‘shared’, ‘system’ and ‘users’. 

 
 

c. Open the Catalog Manager 
a. Go to File and open the catalog online (File->Open catalog) by giving the 

necessary credentials based on your setup (Type - (online), URL - 
(http://<ipaddress>:<port>/analytics/saw.dll). 

b. Once the catalog is opened, it will display a folder structure on left hand side. 
Select the shared folder under root folder in the LHS tree structure. 

c. Go to File menu and select Unarchive. It will ask for the path for a file. 
d. Browse the path of the archived catalog file saved in your local folder using 

the Browse button in the pop up. Click OK. 
e. The catalog will be unarchived in specified location. A pop up for successful 

operation will be shown. Restart the presentation services once again. 
d. Open the analytics OBIEE URL- (http://<ipaddress>:<port>/analytics) Login with 

credentials based on your setup, and verify that catalog is available. 
 

8. Configure tnsnames.ora.  
a. Open "tnsnames.ora" file under the folder - <Oracle Home>/network/admin  
b. Make sure an entry is made in the tnsnames.ora to connect to application 

schema of OFSAA application. 
c. Save the tnsnames.ora 

  
9. Configure ODBC data source to connect to Oracle BI Server.  

 
a. Go to Control Panel>Administrative Tools>Data Sources (ODBC).  
b. Select the System DSN tab and click Add.  
c. Select a driver specific to (Oracle BI Server 11g) and click Finish.  
d. Enter “Name” and “Server” details (Specify the Host Name or IP Address of 

the BI Server and click Next).  
e. Enter Oracle BI Server login id and password (Enter User Name and 

Password created at the time of OBIEE installation). Click Next.  
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f. Click Finish.  
 

10. Modify connection pool and set the properties.  
a. Open the OBI Administration tool.  
b. Select Start > Programs > Oracle Business Intelligence > BI 

Administration.  
c. Select File > Open > Online and select CRMRCA.rpd file.  
d. In the Open dialog box, select and open CRMRCA.rpd file.  
e. Enter Repository password as “Admin123”.  
f. In the “Physical” layer, double-click the CRM Connection Pool under CRM 

Database to open its properties.  
g. In the General tab, edit/check the following entries:  
h. Call Interface: (OCI 10g/11g).  
i. Data source name: <tnsnames.ora entry created in the step 8.b connecting to 

OFSAA application schema>.  
j. User name: <enter application db user name>.  
k. Password: <enter application db user password>.  
l. Confirm password and click OK to close the window. 
m. Repeat the same for CRM Connection Pool (Init Block) 
n. In the "Physical" layer, double-click the CRM Connection Pool under CRM 

Essbase ‟ to open its properties.  

o. Essbase Server :< ip address/Hostname of the Essbase server>Username : 
<Essbase username> 

p. Password : <Essbase password> 
q. Confirm password and click OK to close the window and click Save to save 

the RPD file.  
r. Click No for the Global Consistency Message.  
s. Close the RPD file (File/Exit).  
t. Message.  
u. Close the RPD file (File/Exit).  

 
11. Login into CRMRCA Application using the URL: 

http://localhost:9704/analytics.(Replace the port number based on your setup). 
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Trouble shooting 
Problem: After logging into CRMRCA Application, if end user experiences an error as 

“Exceeded configured maximum number of allowed output prompts, sections, rows, or 

columns” while accessing reports. 

Solution:  

1. Bring down OBIEE Presentation services. 
2. Locate and take a back up of the file ’Instanceconfig.xml’ in following folder structure 

<Oracle BI Instance 
Home>\config\OracleBIPresentationServicesComponent\coreapplication_obips1 

3. Edit the file. Locate the tab ‘<view>’ which in turn contains ‘<pivot>’ tab in 
instanceconfig.xml. 

4. Paste the following lines in between ‘<pivot>’ and ‘</pivot>’ tab. 
<MaxVisibleColumns>3000</MaxVisibleColumns> 
<MaxVisiblePages>10000</MaxVisiblePages> 
<MaxVisibleRows>50000</MaxVisibleRows> 
<MaxVisibleSections>250</MaxVisibleSections> 
<DefaultRowsDisplayed>30</DefaultRowsDisplayed> 

5. Save the file and restart the presentation services. 
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Documentation  
You can download the OBIEE installation and configuration guide from: 

http://www.oracle.com/technology/documentation/bi_ee.html

http://www.oracle.com/technology/documentation/bi_ee.html
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